Kurzweil 3000™ for Macintosh® Web License Edition

© by Kurzweil Educational Systems, Inc., a Cambium Learning Company. Kurzweil Educational Systems is a registered trademark of, and Kurzweil 3000, License-to-Go, and KESI Virtual Printer are trademarks of Kurzweil Educational Systems, Inc. Macintosh is a registered trademark of Apple in the United States and/or other countries. Other product or brand names are trademarks or registered trademarks of their respective holders.

Component Acknowledgments:
The American Heritage® Dictionary of the English Language, Fifth Edition. Copyright © 2011 by Houghton Mifflin Harcourt Company. Published by the Houghton Mifflin Harcourt Company. No part of this database may be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by applicable law.

Words are included in this Dictionary on the basis of their usage. Words that are known to have current trademark registration are shown with an initial capital and are also identified as trademarks. No investigation has been made of common-law trademark rights in any word. The inclusion of any word in this dictionary is not, however, an expression of the Publisher’s opinion as to whether or not it is subject to proprietary rights, nor is it to be regarded as affecting the validity of any trademark.

The American Heritage® Children’s Dictionary by the Editors of the American Heritage® Dictionaries. Copyright © 2009 by Houghton Mifflin Harcourt Company. Published by the Houghton Mifflin Company. No part of this database may be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by applicable law.

Roget’s II: The New Thesaurus, Third Edition by the Editors of the American Heritage® Dictionaries. Copyright © 2009 by Houghton Mifflin Harcourt Company. Published by Houghton Mifflin Company. No part of this database may be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by applicable law.

No investigation has been made of common-law trademark rights in any word. Words that are known to have current trademark registration are shown with an initial capital and are also identified as trademarks. The inclusion or exclusion of any word, or its capitalization in this dictionary is not, however, an expression of the Publisher’s opinion as to whether or not it is subject to proprietary rights, nor is it to be regarded as affecting the validity of any trademark.


ETI-Eloquence™ and RealSpeak™ Copyright Nuance Communications, Inc. All Rights Reserved.

Homophones and confusables word lists from WordSpring™ software. © 2002 Lexia Institute.

Acapela Text-to-Speech from Acapela Group.

OpenDyslexic font © OpenDyslexic.

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson.

The Picture Communication Symbols samples © 1981-2004 Mayer-Johnson, Inc., Solata Beach, CA. USA. All rights reserved worldwide.

Widgit Picture Dictionary © Widgit Software

NIMAS Sample files created by the AIM and NIMAS Centers at CAST, Inc. with support from the Office of Special Education, US Department of Education.

Additional product components are licensed from ExperVision Inc.; WASTE Text Engine © 1993-2002 Marco Piovanelli.

Note About Copyrighted Material
If you upload or install source materials or any other materials on any computer, including, without limitation, your computer, a local area network, or a web-based computer hosted by Kurzweil Educational Systems, Inc., you hereby acknowledge that you have all of the necessary ownership or licensed rights to load such materials and shall fully indemnify Kurzweil Educational Systems, Inc. from any claims that may arise relating to such actions.
Contents

Web License Overview, Set Up and Management .............................................. 1
  Kurzweil 3000 Web License Overview ........................................................ 2
  Web License System Requirements ............................................................ 5
  Installing Web License Client Software ..................................................... 6
    Installing the Acapela Voices ............................................................... 6
    Installing Additional Acapela Voice Sets .............................................. 8
    Installing the OpenDyslexic Font ....................................................... 10
  Working with User Accounts and License Allocation ............................... 13
    Accessing the User Management System ......................................... 13
    Registering Users ............................................................................. 14
    Viewing and Managing Licenses ....................................................... 20
    Managing Users ................................................................................. 21
    Viewing and Changing Your Personal User Information
      and Password ................................................................................. 22
    For Top Level Coordinators ............................................................... 24

Web Universal Library ..................................................................................... 26
  The Web Universal Library Overview ...................................................... 27
    Web Universal Library Structure ........................................................ 27
    Using the Web Universal Library ........................................................ 29

Index ............................................................................................................. 33
1 Web License Overview, Set Up and Management

The information in this guide is arranged into the following main topics:

- Kurzweil 3000 Web License Overview on page 2.
- Web License System Requirements on page 5.
- Installing Web License Client Software on page 6.
- Installing the Acapela Voices on page 6.
- Installing Additional Acapela Voice Sets on page 8.
- Installing the OpenDyslexic Font on page 10.
- Working with User Accounts and License Allocation on page 13.
- Registering Users on page 14.
- Viewing and Managing Licenses on page 20.
- Managing Users on page 21.
- Viewing and Changing Your Personal User Information and Password on page 22.
Kurzweil 3000 Web License Overview

Licenses for Using Kurzweil 3000 Over the Internet

The Kurzweil 3000 Web License product offers convenient, secure Kurzweil 3000 license check in/out through the Web.

Web licenses are stored and managed by Cambium Learning and delivered to users over the Internet.

In addition to placing less of a burden on a school’s technology team, Web Licensing allows users to access licenses and run Kurzweil 3000 from any computer on which the Kurzweil 3000 Web License Client software is installed, and from anywhere on the Internet.

Web License Users

There are three types of users:

- Designated License Coordinator who is set up by Cambium Learning for the organization. This user has the ability to create and manage sub-users and to allot licenses to those sub-users, which can include Student users. When viewing user information, this user can see and change all of his/her sub-users’ information. When viewing Universal Library contents, this user can access all of his/her sub-users’ folders.

- Site coordinator who could be a teacher, principal, or other school authority. Set up by the organization’s license coordinator, this user has the ability to create and manage sub-users, including Student users, and to allot licenses to those sub-users. When viewing user information, the site coordinator/teacher user can see and change all of his/her sub-users’ information. When viewing Universal Library contents, this user can access all of his/her sub-users’ folders.

- Student users are created and registered by any user who can create sub-users. They cannot, however, have sub-users, nor have access other users’ folders in the Universal Library except Public ones created by their teachers or for the organization.
Complemented by Web-Based Universal Library

Included with the Kurzweil 3000 Web License Edition is the Web Universal Library, a robust file repository that provides leveled access to files and documents.

The Web Universal Library enables districts or schools to widely distribute curriculum, and share and reuse material. Any user can upload district-wide curriculum and resource files. Teachers are able to post classwork, and students can access those files and documents from anywhere on the Internet, from any Kurzweil 3000 Web Client computer, at any time.

The Web License Universal Library also includes the Classic Literature collection of nearly 2000 public domain electronic text, from literary classics, factbooks, and references to religious and historical documents.

Roaming Preferences

Once set, Kurzweil 3000 personal preferences, such as reading voice and reading speed, are maintained allowing you to work on Macintosh to Macintosh without having to reset options. (Kurzweil 3000 Macintosh settings are not valid in Kurzweil 3000 Windows systems and vice versa.)
How Does Web License Work?

Once your organization completes the Web License product purchase process, an IT specialist installs the Web License Client Software, and an initial user account is set up by Cambium Learning Customer Service for a designated License Coordinator.

That initial user, who could be a school administrator, IT specialist, even a teacher, then creates sub-user accounts for sub-site coordinators at different schools, teachers and/or students. At the time of user setup, the system generates login information — a username and password — for each user.

Each user, other than Student users, can set up and manage sub-users under his/her account.

To access Kurzweil 3000, log in using the Kurzweil 3000 desktop icon on a computer running Web License Client software.
Web License System Requirements

- A Macintosh with a minimum of a G3 processor, and that is capable of running Mac OS X 10.6 to 10.10.
- Minimum 256 MB RAM.
- Minimum 300MB of hard disk space available.
- DVD drive, keyboard, mouse, speakers, microphone, Internet connection for Read the Web functionality.
- Image Capture-compatible scanner.

Some scanners might not be compatible with the operating system versions required by Kurzweil 3000; and some scanners might not work with Kurzweil 3000 because of TWAIN or Image Capture support, speed and/or quality issues.

For a list of compatible and recommended scanners call Kurzweil Technical Support: 800-894-5374 or +1-781-276-0600 from outside of the United States.

To ensure that your system meets or exceeds the most recent requirements, refer to the Kurzweil website's system requirements page:

https://www.kurzweiledu.com/products/system-requirements-mac.html
Installing Web License Client Software

There are two ways to install Kurzweil 3000: from the DVD or by downloading the application from the Kurzweil website: https://www.kurzweiledu.com/k3mac and choosing Web License from the list.

**Download the Software from Kurzweiledu.com**

1. Go to https://www.kurzweiledu.com/k3mac and select the Kurzweil 3000 Web License link.
2. Choose Save to save the file. This will take some time.

**To install Web License client software:**

1. Place the Kurzweil 3000 DVD into the DVD drive or locate the downloaded file.
2. From the DVD window or the download location, drag the Kurzweil 3000 application icon to your Applications folder.
3. Start Kurzweil 3000 by double-clicking the Kurzweil 3000 icon.

You are ready to log in to and use Web License Edition by clicking the Kurzweil 3000 icon.

**Installing the Acapela Voices**

The Kurzweil 3000 DVD contains voices from Acapela. We recommend that you install these voices on each Macintosh that will run Kurzweil 3000.

**Installing the Voices**

1. Open the Extras folder

<table>
<thead>
<tr>
<th>Extras</th>
<th>1 of 5 selected, 50.4 MB available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Date Modified</td>
</tr>
<tr>
<td>Acapela</td>
<td>Yesterday, 1:08 AM</td>
</tr>
<tr>
<td>Documentation</td>
<td>Yesterday, 1:08 AM</td>
</tr>
<tr>
<td>OpenDyslexic</td>
<td>Yesterday, 1:08 AM</td>
</tr>
</tbody>
</table>
2. Double click the Acapela folder. The installation package file is displayed.

3. Double click the **InstallAcapelaVoices.mpkg** file to start the installation wizard.

4. Click **Continue**, then follow the instructions in the screens that follow.
Installing Additional Acapela Voice Sets

The additional Acapela Voice sets include access to more than a dozen voices in a variety of languages. They are available by downloading from the Kurzweil 3000 website and on a DVD. Following are the additional voice sets and the voices contained in each set.

<table>
<thead>
<tr>
<th>Acapela English Non US Voices</th>
<th>Acapela European Voices One</th>
<th>Acapela European Voices Two</th>
</tr>
</thead>
<tbody>
<tr>
<td>English Australian – Lisa</td>
<td>Dutch – Femke</td>
<td>German – Klaus</td>
</tr>
<tr>
<td>English Australian – Tyler</td>
<td>Dutch Belgian – Jeroen</td>
<td>German – Sarah</td>
</tr>
<tr>
<td>English Indian – Deepa</td>
<td>Dutch Belgian – Sofie</td>
<td>Portuguese – Celia</td>
</tr>
<tr>
<td>English UK – Lucy</td>
<td>French Belgian – Justine</td>
<td>Italian – Fabiana</td>
</tr>
<tr>
<td>English UK – Peter</td>
<td>French – Julie</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Acapela European Voices Three</th>
<th>Acapela North and South American Voices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swedish – Emma</td>
<td>English USA – Laura</td>
</tr>
<tr>
<td>Swedish – Erik</td>
<td>English USA – Rod</td>
</tr>
<tr>
<td>Danish – Rasmus</td>
<td>English USA – Ryan</td>
</tr>
<tr>
<td>Norwegian – Kari</td>
<td>Spanish North America – Rodrigo</td>
</tr>
<tr>
<td>Finnish – Sanna</td>
<td>Portuguese Brazil – Marcia</td>
</tr>
</tbody>
</table>

**Downloading and Installing from the Kurzweil 3000 Website**

1. Go to [https://www.kurzweiledu.com/k3mac](https://www.kurzweiledu.com/k3mac). Use the information shown in the tables above to determine the voice set to download.

2. In the list of Acapela voices, click the link next to the voice set to download. The download begins and will take some time to complete.

3. When the download has completed, double-click the download file (.dmg) in the download window. A window is displayed that contains the installation file (.mpkg) and a readme.txt file.
4. Double-click the installation file (.mpkg). The Welcome screen is displayed. For example:

![Welcome screen for installation]

5. Click **Continue** and follow the instructions to complete the installation.

**Installing from the DVD**

1. Open the voice set that you want to install.
2. Double-click the installation file (.mpkg) to start the installation.
3. Follow the instructions to complete the installation.
Installing the OpenDyslexic Font

The OpenDyslexic font helps to increase readability for readers with dyslexia. The typeface includes Regular, Bold, and Italic styles.

Kurzweil 3000 includes the OpenDyslexic fonts in the Extras folder.

**Installing the Font**

1. Open the **Extras** folder.

2. Double click the **OpenDyslexic** folder. The list of OpenDyslexic fonts is displayed.
3. Double click the font to install, for example \texttt{OpenDyslexic-Bold.otf}. The font is displayed.

![OpenDyslexic Bold Font](image)

\textbf{ABCDEFGHIJKLMNOPQRSTUVWXYZ}
\textbf{abcdefghijklmnopqrstuvwxyz}
\textbf{1234567890}

(Not Installed) \hspace{1cm} \textbf{Install Font}

4. Click \textbf{Install Font}. When it has been installed, the Font book opens showing the installed font style.

![Font Book with Installed OpenDyslexic Bold Font](image)
5. With the Font Book open, you can drag the remaining fonts from the OpenDyslexic folder into the Font Book.

![Font Book screenshot](image)

Working with User Accounts and License Allocation

After your organization purchases a number of Web Licenses, Cambium Learning Customer Service sets up the initial user (typically, this is a designated site coordinator who could be teacher, school administrator or IT specialist). He/she is given username and password for login.

The site coordinator/initial user can then set up the site users, providing them with their system-generated usernames and passwords, and allocating licenses.

Once that is done, any user can log in, set up, manage and distribute licenses to sub-users under their accounts.

Sub-users are typically teachers who set up their own sub-users, typically students. Student users, however, do not have User Management access.

Accessing the User Management System

Go to https://accounts.fireflybykurzweil.com and log in.

Note: From Kurzweil 3000, you can access your firefly account by choosing My Account from the File menu. If you need frequent access to this link, consider using Tools > Customize Toolbars to place the My Account button on a toolbar.
The **Home** page opens displaying site account information such as the number of licenses purchased, allocated and activated.

Along the top, right-hand area are three tabs: **Home**, **My Account** and **Help**. **Log Out** is in the upper-right-hand corner of the *firefly* window.

**Registering Users**

There are three ways to register sub-users under your account:

- You can use Kurzweil’s free user import and rostering service.
- You can register each user yourself using the Add Users feature.
- You can initiate self-registration and send a link to the users you want to self-register.

**Using User Import and Rostering Service**

If you purchased a site or district license, we offer a free user import and rostering service. It is recommended that we create your user accounts through this import process, instead of manually creating user accounts (a process that is explained in this document). To take advantage of the free import and rostering service, please email *fireflyroster@cambiumtech.com*.

**Using the Add Users Feature**

1. Log in. Your **Home** page opens (or, if you were logged on previously and then logged out from a different page, the **Profile** page for example, that page will open).
2. Hover the cursor over the **My Account** tab to display the menu.

3. Select **Users** from the drop-down menu. Your **Team** page will open.

4. Click the **Everyone** icon and when it opens, click the **Add User** tab.

5. Add the user information: **First Name**, **Last Name**, **Password**, **Email**, **School/Org**, and **External Id**. The **Student** box is pre-checked. If you are adding a teacher, uncheck the **Student** box. The **External ID** can be any identifier that you want – a Student ID Number, for example. This field is only used as a search field. **Note**: if you specify a password, the password must be at least 5 characters with no apostrophes. All other
fields are required. If the user has a valid email address the login information is automatically emailed to the user. If the user does not have an email address, enter the TLC’s email address as a placeholder. You will then need to provide the user the login information.

**Note:** If you have more than one user to enter, use the drop-down list to select a number of fields to add, and click **Add More**. The number you select will add that many more lines of fields.

---

<table>
<thead>
<tr>
<th>Students</th>
<th>Teachers</th>
<th>Add Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Size: 0</td>
<td>Total Licenses: 24</td>
<td>Allocated Licenses: 10</td>
</tr>
<tr>
<td>Remaining Licenses: 0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. When you have finished adding users, click **Save**.

The user information then appears in the Student or Teacher list on the Everyone page, along with the system-generated username and password (if you didn’t already provide one).

Note that these usernames and passwords can also be used to login to the Kurzweil 3000 Web License Product and the free **firefly** iPad application that can be downloaded from [https://www.kurzweiledu.com/kurzweil-3000-firefly-ipad-app.html](https://www.kurzweiledu.com/kurzweil-3000-firefly-ipad-app.html).

**Initiate User Self-Registration**

Links to the self-registration form enable teachers and students to add themselves to the firefly roster. Only the top-level coordinator can initiate self-registration.
1. Hover the cursor over the **My Account** tab to display the menu.

2. Select **Users** from the drop-down menu. Your My Team page opens.

3. Click **Self-Registration**. A window opens that displays a link for you to copy and send to teachers and a link for you to copy and send to students. **Note**: Because teachers and students have different privileges, it’s important to send the correct link.
4. Click the **Copy** button next to the appropriate link (Teacher self-registration or Student self-registration).

5. Open your email application and address an email to the teachers or students you want to self-register.

6. In the message section of the email, paste the link you copied from the self-registration window.

7. Send.

   The recipient will click the link in the email they’ve received and the User Self-Registration form will display.
After filling in the information and clicking the **Add New** button, a “Success” message will display that includes the username, password, and a link to the login form.
Viewing and Managing Licenses

To view license information:

1. Hover the cursor over the **My Account** tab and choose **Users** from the drop-down menu. Open any of the Everyone pages (Student, Teachers, or Add Users) or your Team page.

   ![Image showing license information management](image)

2. At the top of the page you can find:
   - **Total Licenses**: the total number of licenses for your site.
   - **Allocated Licenses**: the number of licenses distributed among users.
   - **Remaining Licenses**: the number of licenses remaining; that is the Total Licenses minus the Allocated Licenses.
Managing Users

To Update User Information:

1. Hover the cursor over the **My Account** tab and choose **Users** from the drop-down menu. Click your Team icon.

2. Locate the user to be updated. Note that lists can be sorted alphabetically in ascending or descending order by selecting the down or up arrows at the top of each column. You can also use any of the search fields at the top of the list.

3. All the text fields can be edited. Place your cursor in a field that needs updating and start typing. The line of fields is outlined in yellow and you'll notice that the Save button is activated. Note: To change the password, click the Show link beneath the Password column heading.

4. Click **Save** when you have finished making changes. Note that these changes will appear on the Everyone list and on any Team page the user information appears.
To Remove a User from Your Team:

Only a TLC can delete a user, but you can remove a user from your Team page. The user will still exist on the Everyone list.

1. Hover the cursor over the My Account tab and choose Users from the drop-down menu.
2. Click your Team or the Everyone icon.
3. Find the user that you want to remove from your Team and click the Remove button to the right of the user information if you are on your Team page or uncheck the checkbox to the right of the user information if you are on the Everyone page. Either of these actions will remove the user from your Team page.

Viewing and Changing Your Personal User Information and Password

To view and change your own user information, including password:

1. Hover the cursor over My Account to display the menu, then click Profile.
The **Manage Profile** page includes user information such as address and occupation, login, and school/organization information.

2. Make the desired changes.

3. Then click **Update Account Information**.

**Forgot Password?**

1. Click the **Forgot Password** in the log in page.

2. In the **Forgot Password?** page, enter the email address associated with your account.

3. Your username and the original password will be emailed to you.

4. Use the emailed password to log in.

5. Go to and follow the instructions in To view and change your own user information above.
For Top Level Coordinators

Only a Top Level Coordinator (TLC) can delete a user. Later, if needed, the TLC can restore that user. Notice that the TLC Coordinator has an additional icon: Restore Users.

To Delete a User

1. Log in as TLC.
2. Open the Everyone Page. In the right column you will notice a trash can icon next to each user in the list.
3. Click the Delete button next to each user that you want to delete.
To Restore Users

There are times when the TLC may need to restore a user that was deleted. To Restore a User:

1. Click the **Restore Users** button. A list of Users who were previously removed is displayed.

2. Click the **Restore** button in the right column next to each user that you want to restore.

3. The user(s) will be restored to the **Everyone** list.
This chapter contains four main sections.

- *The Web Universal Library Overview* on page 27 has the following subsections:
  - *Web Universal Library Structure* on page 27.
- *Using the Web Universal Library* on page 29 has the following subsections:
  - *To open a document from the Library*: on page 29.
  - *To save an open document to the Library*: on page 30.
  - *To create a new folder in the Universal Library*: on page 30.
  - *To rename a file or folder in the Universal Library*: on page 30.
  - *To delete a file or directory in the Universal Library*: on page 31.
  - *To cut or copy, and paste a file or folder in the Universal Library*: on page 31.
The Web Universal Library Overview

Kurzweil 3000 Web License Edition includes the Web Universal Library. If your school uses the Kurzweil 3000 Local Area Network (LAN) Universal Library, you are already aware of the benefits of central file storage and sharing.

The Kurzweil 3000 Web Universal Library, however, is an expanded version of the LAN Universal Library. Because the Web Universal Library is Internet-based, it allows students and teachers, or any authorized users, using any computer running Web License Client software from anywhere on the World Wide Web, to access and share files.

For districts and schools, the Web Universal Library is ideal for placing standardized curriculum material and print resources in electronic form for all or for specific groups to access. Teachers can make class files available wherever, whenever students need them.

Included in each Web Universal Library are the following folders:

- Classic Literature, a collection of nearly 2000 books, historical documents selected from the public domain
- Samples, files from Cambium Learning Group's published educational series, LANGUAGE!, Learning A-Z and Passport Reading Journeys.

Web Universal Library Structure

The structure of the Universal Library is based on user/sub-user file system concept where each authorized user can set up and manage his/her sub-users.

In addition to sub-user folders, each user also has a Public folder and a Private folder. All users have Read-Write permission to his/her own and to sub-users’ Public and Private folders.

Sub-users only have Read access to the Public folder of the user who created their account.

For example, a district could set up folders for each school. In a school's folder, there could be folders for teachers as well as a Public and a Private
folder. All teachers and students in the school could access the school’s Public folder. Teachers would not be able to access one another’s folders.

Each teacher folder in turn would have the teacher’s students’ folders, plus a Public and Private folder. All students whose accounts a teacher creates would be able to access their teacher’s Public folder. Students would not be able to access one another’s folders.
Using the Web Universal Library

You can open and save to the Universal Library and manage folders and files by using either the Open from the Universal Library or Save to the Universal Library.

The Web Universal Library currently supports RTF, TXT and KES file formats.

To open a document from the Library:

1. From the File menu, choose Open from Library to open the Universal Library.

2. Navigate to the desired folder and file, then click Open.

3. Use the Kurzweil 3000 Reader to read the file.
To save an open document to the Library:

1. Open the document you want to save to the library.
2. From the File menu, choose Save to Universal Library.
3. In the dialog, specify where you want to place the file by clicking the desired folder in the left-hand pane.
4. Click Save.

Notes:

• When saving a file, you are uploading it to the Web server, and the time and speed by which a file is uploaded depend on the Internet line and service at your site. We recommend 50 pages or fewer per file, so it's a good idea to separate chapters and save a chapter at a time.
• You can only save to the directories for which you have access privileges.
• No user can save files to the Classic Literature folder.

To create a new folder in the Universal Library:

You can create a new folder in the following places:

• Under your own user directory, in the Private and Public folders.
• In the Public folders of directories belonging to sub-users whose accounts you created.

1. From the File menu, choose Save to Universal Library.
2. In the dialog, in the left-hand pane, select the directory under which you want to create the new folder.
3. Click the New Folder button.
4. Rename the folder.

To rename a file or folder in the Universal Library:

1. Select the file or folder.
2. Click again or press Return to begin editing.
3. Type the new name, then press Return.
To delete a file or directory in the Universal Library:

1. From the File menu, choose either Open from or Save to Universal Library.

2. In the dialog, do one of the following:
   - In the left-hand pane, select the directory you want to delete.
   - In the right-hand pane, select the file you want to delete.

3. Do one of the following:
   - Control-click and in the context menu, choose Delete.
   - Use the Forward-Delete or Backward-Delete shortcuts.

Notes:
- If you use the Delete command in the Save to Universal Library dialog, you have to click Save to close the dialog when you are done.
- You can only delete from the directories for which you have access privileges.
- No user can delete files from the Classic Literature folder.

To cut or copy, and paste a file or folder in the Universal Library

1. From the File menu, choose Open from Universal Library.

2. In the dialog, do the following:
   - In the left-hand pane, navigate to and select the folder you want to cut or copy, or the folder that contains the file you want to cut or copy. You can only cut or copy folders that are inside your public or private folder.
   - In the right-hand pane, select the file you want to cut or copy.

3. Control-click to show the context menu, choose Cut or Copy.

4. Do one of the following:
   - To paste a file into another folder in the Universal Library, navigate to the desired folder in the left-hand pane, click in the right-hand pane, control-click to show the context menu, and then choose Paste.
To paste a folder into another folder in the Universal Library, navigate to the desired folder in the left-hand pane, control-click to show the context menu, and then choose Paste.

To paste a file or folder elsewhere on your desktop or system, navigate to that location, control-click to show the context menu, and then choose Paste.

**Notes:**

- Note that you can only paste if you have Copy To privileges.
- It is possible to Copy-Paste files and folders from the Universal Library to the Finder, and files (not folders) from the Finder to the Universal Library.
- No user can cut files from or paste files into the Classic Literature folder.
Index

A
Acapela Voice sets
   additional 8
Acapela Voices
   installing 6

D
Designated License Coordinator 2
Dyslexia
   OpenDyslexic font for 10

F
firefly 13
Font
   OpenDyslexic 10

I
Installing
   Acapela Voices 6
   OpenDyslexic font 10
   Web License Client software 6
installing
   Acapela Voices 6
   additional Acapela Voice sets 8

K
Kurzweil 3000
   Installing 6
   using over the Internet 2

L
License Coordinator 4
Licenses
   Viewing and Managing 20

O
OpenDyslexic font 10

P
Password
   changing 22
   Personal preferences 3

R
registering users 14

S
saving
   a document to Web Universal Library 30
scanner
   compatibility with Kurzweil 3000 5
Site coordinator 2
Student users 2
Sub-site coordinators 4
Sub-user accounts 4
System requirements 5

U
user management
   access to 13
Users
   types of 2
   users
      registering 14

W
Web License
   how it works 4
Web License Client software
   installing 6
Web Universal Library 3
   overview 27
   saving a document to 30
structure 27